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Description 

The Fusion 360 team often hears, from beginning users, comments such as: “Fusion is so hard 
to learn.  I don’t know where to start.  There are so many commands and workspaces, it’s too 
intimidating”.  We are here to bust that myth.  In this class, we will demonstrate, live, creating a 
real-world design (not a trivial demo design) using just 12 commands in the Design workspace.   

Join your expert Fusion instructors, Phil and Jeff for this interactive demo/training class aimed at 
newer Fusion users who just want to learn the basics.  Once you’ve mastered these 12 
commands, you will have skills to create moderately complex designs, and, with that 
confidence, you can expand your knowledge by learning the rest at your own pace. You’ll leave 
the class with a good foundation built on basic skills along with keys to further explorations in 
areas that matter to you. 

 

Speaker(s) 

Phil is a Principal Software Engineer for Autodesk on the Fusion 360 team primarily testing 
design workflows and crashes.  Before Autodesk he used Inventor starting at R1. He enjoys 
working with the online Fusion community and teaching Fusion at a local community college.  
 

Jeff is a Director of Software Development at Autodesk.  “I’ve been with Fusion since the very 
beginning (before parametrics, before XRef…).  My focus is on general modeling/sketching. 
Before that, I was a developer and architect on Inventor, also before R1.  So, I’m a long-time 
CAD guy. When not working with Fusion or its customers, I like to run, cycle, hike, and read 
science fiction.”  

Learning Objectives 

• Learn how to use 12 essential Fusion 360 design commands 

• Learn how to put those 12 commands together to create real-world designs 

• Gain confidence in your Fusion abilities, without being intimidated by the wide 
range of Fusion commands 

• Explore sketching, solid modeling, and assembly modeling with a minimum number 
of interactions 
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The purpose of this class 

Learning a new CAD tool is a lot like learning a language. It can be intimidating and confusing, 
but once you know some concepts in areas of grammar and structure, and some simple 
vocabulary of commonly used words, you’ll soon be composing sentences and communicating 
your thoughts. The very act of composition can begin to drive further integration with the 
language, to create ideas and combine them. The combining of ideas is more powerful than the 
singular application of them. This progression is also a way to learn a new CAD application. 
This class introduces the grammar, basic words, and sentence structure of Fusion 360. 
 
Starting with the basic commands that get the most work done, you can then expand your 
skillset to combine these commands and others into more complex expressions of your design 
intent. This class intends to speed this process by providing a firm foundation by which later 
growth is supported and accelerated.  
 

How much is enough 
Is 12 or 15 commands enough? Including too much would be diluting the impact by adding too 
many “essential” commands. The choice of what qualifies as essential is debatable by experts, 
with valid reasoning, from a myriad of backgrounds in design and manufacturing. They may 
disagree somewhat, but there is an undeniable, and short, list of requirements for what could be 
called a “CAD Foundation”, when applied to learning any CAD product. We’re trying to provide 
that here for Fusion 360. We strived for 12, but in the end expanding to 15 was required. 
 
The design selected was chosen to represent the cornerstone blocks of that CAD foundation - a 
robot arm with a gripper. It has components, motion, sketches, and a realistic parts list. These 
basic elements are the things you need to get right in every design, simple or otherwise. 
 

Assembly structure 
The design chosen for this class requires components. Components have motion, part 
numbers, can be used in exploded diagrams, and so forth. Components are parts. This 
class shows how they are made, how they are assembled together, and how this 
assembly structure represents a simple, yet realistic design.  
 

 
THE ROBOT GRIPPER ARM ASSEMBLY 
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Sketch essentials 

The shapes in the chosen design are simple and easy to create with a handful of the 
most common sketch commands: lines, arcs, circles, and a few more. Working at this 
granular level of design, creating the elemental particles of your design, you’ll start to 
see why more complex sketch commands exist.  

For example, expanding on the analogy of particles and extending it to molecules, you 
can draw a slot with two circles and two lines (particles), or you can use the slot 
command, which is just an automated combination of lines and arcs, but is slightly more 
complicated. In the case of slots, the trade off between complexity and productivity 
comes when you start to ask “How could this be easier?” Starting with basics, and 
expanding as opportunity presents is what this class suggests. 
 

Modeling core commands 

Similar to the thinking about sketch commands, there are just 4 commands representing 
3D geometry creation used for this design. Extrude, hole, fillet, and offset workplane. If 
you haven’t heard the 80/20 rule, this is it in a nutshell: A fraction of the available tools 
do the majority of the work.  

But each of these workflows, once you know them, will lead you to ask how the more 
complex commands could be utilized for greater effect, and perhaps increase efficiency. 
Without the basics, the complex commands are not seen in the right context, and can be 
a fancy way to “model yourself into a corner”. Yes, they are more efficient, but with great 
power comes great responsibility. You can’t skip over the responsibility part, but you’re 
here, so that’s a good start. 
 
 

In the sections below, you’ll find a step by step guide to designing this assembly. Along with 
diagrams and instructions, there will be explanations about expanding the skills shown into 
more complex workflows and commands. 
 
 

 
THE GRIPPER ASSEMBLY 
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The demonstration 

What follows is a step-by-step guide based on the construction of the sample design. The live 
video will necessarily vary from this guide in a few ways. First, this paper skips no steps. Live, it 
was necessary to condense the demonstration both for reasons of time, and to avoid needless 
redundancy. Here you’ll find every step to create the model yourself. 
 

The model 
Starting at the same place as in the live class, the model will start with the gear box, and 
modeling will proceed out along the “arm” to the end of the gripping hand. 
 
All images and diagrams are taken from the reference model. This model is available for 
download in the Autodesk Gallery using this link. 
 
In the tutorial instructions that follow, commands are listed by name in italics. Paths to 
commands are shown by (menu name) > (command name). Example: Create > Create Sketch 

 
At the end of each section is a list of commands used, with each newly introduced command 
highlighted. Also you’ll find some observations about each stage of design development. 
 

 

https://gallery.autodesk.com/projects/171421/robot-arm-9
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Step 1 – Gear box component 
 

 
THE FINISHED GEAR BOX COMPONENT (SELECTED) 

 
 

1. Create > New Component, name it “gear box” and make it active.  
2. Save the design. 
3. Create > Create Sketch on YZ plane. 
4. Create > Rectangle > Center Rectangle. Start on origin. 250 x 250 mm size. 

 
5. Finish the sketch and use Create > Extrude. Enter 150 mm for distance. 
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6. Now that you have a 3D shape, you can refine the design by adding features. In 
this case it needs a hole through the center.  

a. Create > Hole. Select the face, and then drag the center to snap with the 
dot that appears on the center of the face. You’ll use this method a few 
times later in this tutorial. 

b. Make a simple hole, thru all, 30 mm diameter. “Simple” is the default 
style, you just need to add the diameter and make the termination “All”.  

 
7. Finish this component by locking all degrees of freedom to move using a joint 

command. This is so it will not move as you attach more components to it.  
a. Assemble > As-BuiltJoint, rigid type. Select the gear box component and 

design origin component, in the model browser, as the two components. 
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Commands used: 

• New Component 

• New Sketch 

• Center Rectangle 

• Extrude 

• Hole 

• Fillet 

• As-Built Joint or Ground 
 
Insights:  

• The best way to start an assembly design is to create a component, make it 
active, and then add sketches and modeling features.  

 

• Also, it’s critical to connect sketch geometry to the sketch origin and fully define 
the sketch with dimensions and constraints.  

 

• If the design is symmetrical, use the sketch origin as the center of the diagram. 
Using Center Rectangle makes this easy. 

  

1 

2 
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Step 2 – Mounting plate 
 

 
THE FINISHED MOUNTING PLATE (ACTIVATED) 

 
 

1. Activate the top level browser node (click the small dot next to the name). 

2. Create > New Component. Name it “mounting plate” and ensure it is activated. 

3. Create > New Sketch on front of gear box component. 

4. Create > Circle > Center Diameter Circle: diameter 450 mm. 

 

5. Solid > Create > Extrude. Select the three sketch profiles inside the circle. Direction 

and distance is 20mm away from the gear box. 
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6. Look for Sketch1 in the main mounting plate component in the model browser. Click 

the eye icon to make it visible. 

 

7. Extrude the center shaft shape. 
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8. On the front of the mounting plate create this New Sketch. 

 

9. Extrude the two top rectangles 100 mm.  

10. Make the sketch visible again, Extrude the three bottom rectangles 80 mm. 
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11. Add full-round fillets using Modify > Fillet > (type) Full Round Fillet. 

 

12. Create > Hole. Add Ø 15 mm holes thru the centers of the full-round fillets. Use the 

technique you used on the gear box, drag the hole center to snap to the center point. 

 

13. Assemble > As-Built Joint. Use a revolute joint to the gearbox using the shaft axis. 
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Commands used: 

• New Component 

• New Sketch 

• Sketch line 

• Sketch dimension 

• Extrude 

• Hole 

• Fillet 

• As-Built Joint  
 
Insights:  

• Using an existing part as a location to place and create a component that shares 
geometry with it is a best practice. This creates a parametric relationship 
between the parts, which is often called “associative” if done this way. Edits to 
the gear box shape are associatively tied to the first sketch of the plate. 
 

• Sketches are consumed by features, but you can make them visible again and 
enable more features to consume the same sketch. 

 

• As-Built joint is intended to make defining motion easy when components are 
modeled in place together. 
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Step 3 – Upper Arm 
 

 
THE FINISHED UPPER ARM (ACTIVATED) 

 
 

1. Activate the top level browser node.  

2. Create > New Component, call it “upper arm”. Activate it. 

3. Create > New Sketch on the outside face of the taller extruded rectangles on the 

plate. 
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4. Complete sketch:  
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5. Solid > Create > Extrude the shape 15mm away from the plate. 

6. Modify > Fillet > Full-round Fillets at each end of the arm. 

7. Add more full-round fillets inside the slot shapes. 

 

8. Make an As-Built Joint, Revolute, between the top of the arm and the plate. 

 

9. Right click the upper arm component. Copy and paste it to make another 

instance. 
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10. Use Assemble > Joint to add a revolute Joint to to the second arm to place it on 

the opposite side of the plate. 

11. Use Assemble > As-Built Joint. Picking the two arms for a rigid joint. This will 

make them move together. 

 

 

Commands used: 

• New Component 

• New Sketch 

• Sketch line 

• Sketch circle 

• Sketch dimension 

• Extrude 

• Fillet 

• Joint 

• Copy/Paste 

• As-Built Joint  
 
Insights:  

• Creating another instance of a component is easily done with copy/paste hotkeys 
(ctrl+c / ctrl+v) , but the key to success is using the model browser to make the 
component selection. 

• Rigid Group/Rigid As-Built joint is a way to make components move together. 
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Step 4 – Lower Arm Assembly 
 

 
FINISHED LOWER ARM ASSEMBLY 

 
This is our first “out of place” component, and our first sub-assembly.  We will be building this 
based on one of the global origin planes, because there is no convenient plane on the upper 
arm component to create the base sketch.  This step will show the method used to create 
components that are not built in place, and the use of the Joint command to connect them to the 
rest of our design. 
 

1. Activate the top level browser node. 

2. Create > New Component , named “lower arm assy”, activate it. 

3. Create > New Component, name it “lower arm”, activate it.  

a. This step creates a sub-component inside the one you just made called 

“lower arm assembly” and makes it into a sub-assembly, which is an 

assembly inside another assembly. A group of parts that works together 

is an assembly and these can be nested inside of larger assemblies. 
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4. Create > New Sketch, selecting the global YZ plane. 

 

 

5. Create the sketch geometry: two circles, centered on the sketch origin, 

dimensioned as shown, and one vertical line to the left of the origin: 
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6. Extrude the outer cylinder by 900 mm: 

 

 

7. Make the sketch visible, and Extrude the mounting tab on the back side, -

100mm, from the geometry defined by the circles and the vertical line: 
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8. Add a Hole to the center of this mounting face, 15mm in diameter, through the 

mounting tab: 

 
9. Activate the “lower arm assy” component. 

10. Create > New Component  named “lower arm shaft” so that it is a sibling to the 

“lower arm” component (both nested under “lower arm assy”). 

11. Create > New Sketch, selecting the end face of the “lower arm” component.  

Note:  We will be building this shaft in-place with respect to the “lower arm”. 

 
12. No sketch geometry is needed for this component.  By sketching on model 

geometry, we have all the geometry we need! 
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13. Extrude the inner circle, using a “Two Sides” direction (this is new).  800 mm into 

the “lower arm”, 200 mm outside: 

 
14. Add a Hole to the end of the shaft. Key: selecting the 9 o’clock position on the 

cylindrical face: 
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15. Place an As-Built Joint between the shaft and the arm, motion type of Slider, and 

choose a point on the shaft cylinder to define the motion to be along the cylinder 

axis: 

 

 

16. Because the sub-assembly was not built in place with the rest of the design, we 

use a Joint to both position the “lower arm” component with respect to the “upper 

arm” component, and to define its motion (Revolute Joint).  Choose the center of 

the mounting holes on the “lower arm” and “upper arm” components: 

 

17. Now, we need one more instance of the “lower arm assy” component.  Select it in 
the browser, then Copy and Paste it to make another instance. 
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18. After pasting, the move command starts to allow you to position the newly pasted 

sub-assembly. This is for convenience, but it helps to get it closer to the place it 

joins the assembly. We need this to be rotated so that the flat part of the 

mounting tab is in line with the vertical face of the second “upper arm” 

component instance.  A temporary position for this component is okay, because 

we will use a Joint to position this component into the permanent location. 

 
19. Assemble > Joint betweent the mounting holes on the second instance of “lower 

arm”, and the second instance of “upper arm”, type Revolute. 
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20. Because we want the two lower arms to move in tandem, create an As-Built Joint 

between the two instance of both “lower arm” and “lower arm shaft”, with type 

Rigid.  This assures that they will move together. 

 

Commands used: 

• New Component 

• New Sketch 

• Sketch line 

• Sketch circle 

• Sketch dimension 

• Extrude 

• Hole 

• Joint 

• Copy/Paste 

• As-Built Joint  
 
Insights:  

• Creating a component not in position is useful sometimes. 

• Creating sub-assemblies with joints internal to the member components means 
less joints to create later. 

• The Joint command defines position and motion of two components relative to 
each other. 
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Step 5 – Actuator Assembly 
 

 
THE FINISHED ACTUATOR ASSEMBLY (ACTIVATED) 

 
 

1. Activate the top level browser node. Time for another sub-assembly. 

2. Create > New Component, named “actuator assembly”, activate it. 

3. Create > New Component , named “actuator body”. 

4. Create > New Sketch on the YZ plane. 

5. Create > Rectangle > Center Rectangle, 100 x 225 mm. 
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6. Extrude the rectangle 50 mm. Note: Inspect > Display Component Colors is 

turned on in the following images for clarity: 

 

7. New Sketch on the front of that shape: 
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8. Extrude the top circle 150 mm: 

 

9. Make the sketch visible again using the “eye” visibility control for it in the 

browser. Extrude two of the lower profiles 850 mm to produce this result: 
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10. New Sketch on the side facing away from the last two extrudes and make this 

sketch: 

 

11. Extrude the rectangle 100 mm: 
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12. Use the Hole command to place a Ø15 mm hole, centered on this face, with a 

distance of 45mm: 

 

13. Add a Full Round Fillet to the shape: 
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14. Activate the component called “actuator assembly”. 

15. Create > New Component: “Actuator shaft”. 

16. New Sketch: on the end of the actuator body component: 

 

17. Finish the sketch without drawing anything. Fusion is including all the geometry 

needed, getting it from the face of the other component.  

18. Extrude the center circle with the settings: Direction: Two Sides, 200, 800 mm: 
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19. Create a Ø15 mm Hole near the exposed end of the shaft, using the 9 o’clock 

snapping position of the hole angle manipulator: 

  

20. Make an As-Built Joint, Slider type, between the actuator shaft and actuator 

body: 
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21. Use a Joint with Revolute motion to attach the actuator body to the mounting 

plate: 

 

Commands used: 

• New Component 

• New Sketch 

• Sketch line 

• Sketch circle 

• Sketch center rectangle 

• Sketch dimension 

• Extrude 

• Hole 

• Joint 

• As-Built Joint  
 
Insights:  

• Sometimes you don’t need to add anything to a sketch to extrude with it. The 
edges are included when you sketch on a face. 

• When two components are created from one sketch, you can take advantage of 

the As-Built Joint workflow, defining movement based on As-Built position. 
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Step 6 – Pins 1 and 2 
 

 
PINS 1 AND 2 FINISHED (SELECTED) 

 
 

1. Activate the top level browser node. 

2. Create > New Component: Pin 1, activate it. 

3. New Sketch, on the outer face of the upper arm:  

 

4. Extrude profile that fills the pin hole using extent type: To-Object. Select the outer 

face of the other upper arm: 
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5. Create a rigid As-Built Joint between the pin and the upper arm components: 

 

6. Activate the top level of the assembly. 

7. Create > New Component: name it Pin 2, activate it. 

8. Repeat the process you used for Pin 1. 

a. New Sketch on the outer face of the upper arm 

b. Extrude the pin shape using Extent Type: To Object. 

c. Pick the opposite upper arm, outer face as the object. 

d. Finish the extrude and apply a rigid As-Built Joint between the pin and the 

upper arm. 
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Commands used: 

• New Component 

• New Sketch 

• Extrude 

• As-Built Joint  
 
Insights:  

• Sometimes you don’t need to add anything to a sketch to extrude with it. The 
edges are included when you sketch on a face. 
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Step 7 – Additional instances of the actuator assembly 
 

 
ADDITIONAL ACCTUATOR ASSEMBLIES AFTER INSTALLATION  (SELECTED) 

 
 

1. Activate the top level browser node. 

2. Select the first actuator assembly in the browser.  

3. Copy and Paste it to make another instance. 

4. After paste, move the new instance to the side. A temporary location is okay for 

now, we’ll use a joint to put it into it’s permanent position. 

5. Repeat step 4 so that you have 3 new actuator assemblies floating in space 

nearby, ready to be jointed to the overall assembly. 
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6. Use a revolute Joint to position the actuators, one by one into the positions 

shown in the images below: 
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7. Apply an As-Built rigid joint to these two highlighted components. This will make 

the newly installed actuator assembly rotate in unison with the lower arm 

assembly: 

 

8. Repeat the process for the inner sliding parts. They will slide in/out in unison: 

 



 
 

 

 

Page 40 

9. Now use a similar process to make the two new actuator assemblies attached to 

the mounting plate behave in unison. Start by adding an As-Built rigid joint 

between the two newly pasted actuator bodies: 

 

10. Finish by adding an As-Built rigid joint between the two corresponding actuator 

shafts, so they move in/out in unison: 
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Commands used: 

• Copy/Paste component 

• Joint 

• As-Built Joint  
 
Insights:  

• Joints provide position and motion when you need to provide both. 

• As-Built Joints provide only motion between components (or rigid relationships) 

when the relative position is already established. 
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Step 8 – Lower arm bracket 
 

 
LOWER ARM BRACKET  (SELECTED) 

 
 

1. Activate the top level browser node. 

2. Create > New Component, name it “lower arm bracket”. Activate it. 

3. New command: Construct > Offset Plane, from the front of the actuator 

assembly on the lower portion of the assembly. Give it a value of 188 

mm: 
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4. Create a New Sketch on the plane you just created.  

5. Use Sketch > Create > Project / Include > Intersect. 

6. Select the three bodies that intersect the sketch plane: 

 

7. Finish the sketch with center rectangle, lines, and dimensions: 

 

LOWER ARM BRACKET SKETCH 
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8. Extrude the sketch 40 mm: 

 

9. Use the Hole command to create a Ø15 mm hole in the center of the face 

of the top tab, either side will do: 
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10. Make a rigid As-Built Joint between the lower arm bracket and the 

actuator body: 

 

Commands used: 

• New Component 

• Offset Plane 

• New Sketch 

• Sketch project geometry 

• Sketch rectangle 

• Sketch line 

• Sketch dimension 

• Extrude 

• As-Built Joint  
 
Insights:  

• An offset plane is the right way to put a sketch where there isn’t any model 
surface or origin plane to sketch on. 

• A rigid As-Built joint is the CAD equivalent of gluing or bolting a part to another. 
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Step 9 – Connect the top actuator assembly with a joint 
 

 
TOP ACTUATOR ASSEMBLY CONNECTED  (SELECTED) 

 
 

1. Activate the top level browser node. 

2. This is not required, but it helps to drag the end of the actuator assembly 

towards the lower arm bracket. 

a. Start from a view similar to the image above step 1. 

b. Click and drag the end of the actuator shaft down towards the 

lower arm bracket.  

c. Stop when just above the location of the joint you’re about to build. 



 
 

 

 

Page 47 

 

3. Zoom into the area. 

4. Start the Joint command.  

a. On the Position tab, the first snap for Component 1 requires 

getting the mouse onto the cylinder face of the hole, and then 

pressing ctrl/command to isolate the selectable points. This allows 

you to pick the middle point triangle icon: 

 

b. The second snap, for Component 2, is made using the Between 

Two Faces mode.  

c. Change the mode to Between Two Faces. 
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d. Select the two faces shown highlighted in blue below for Plane 1 

and Plane 2. This will require you to orbit to make the selections. 

e. Select the Snap point using the edge of one of the holes. 

f. Click OK. 

 

5. Capture the position: 

 

Commands used: 

• Joint command 

• Capture position 
 
Insights:  

• Similar to the many Extrude command dialog options, you can see in this 
workflow that there are many options to explore in the Joint command dialog 
when it comes to connecting geometry on the Position tab. 

• Capture Position is not on the 12 commands list because it’s a passively 
activated command. Fusion will force you to decide to capture a position when a 
component has been moved and you start a parametric command. For more 
information about Capture Position please refer to this help page.  
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Step 10 – Connect the lower actuator assemblies with a joint 
 

 

 

LOWER ACTUATOR ASSEMBLIES CONNECTED  (SELECTED) 

 
 

1. Activate the top level browser node. 

2. The next step benefits from temporarily grounding the upper arm. Ground 

is not on the 12 commands list because it is not absolutely required. It’s 

called out here as the kind of next level command you would discover by 

doing these joint assembly workflows. Ground works like a clamp to lock 

a part in place and prevent movement. It becomes a timeline event. 

a. Right click on the upper arm component and pick “Ground”: 
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3. Following a similar workflow as before, using the mouse pointer and left 

mouse button, drag the end of the actuator assemblies towards the pin: 

 

4. Zoom into the area. Focus on just one of the ends, either will do the job. 

5. Start the Joint command.  

a. On the Position tab, the first snap for Component 1 again requires 

getting the mouse onto the cylinder face of the hole, and then 

pressing ctrl/command to isolate the selectable points. This allows 

you to pick the middle point triangle icon: 

 

b. The second snap, for Component 2, is made using Simple mode. 

Hover the mouse over the mid point of the pin and select the 

triangle icon when it appears: 
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c. On the Motion tab, change the Motion type to Cylindrical: 

 

6. Press OK. 

7. Right click on the upper arm component and use “Unground” to release 

the temporary grounded state. The timeline shows this sequence when 

you are done: 

 

Commands used: 

• Joint command 
 
Insights:  

• Right clicking on browser objects, such as components, to find special 
commands that apply only to that object, such as ground/unground. 
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Step 11 – Create the lower arm end bracket 
 

 

 

LOWER ARM END BRACKET  (SELECTED) 

 
1. Activate the top level browser node. 

2. Create > New Component, “lower arm end bracket”, activate it. 

3. Construct > Offset Plane, from the end of the center actuator shaft. The 

distance is -45 mm: 
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4. Similar to the lower arm bracket, sketch on this plane. 

5. Use Create > Project/Include > Intersect to project the cross section of 

the parts that intersect the sketch plane. These will be purple shapes. 

6. Create a Center Rectangle, centered on the middle projected circle. 350 

mm wide by 100 mm tall: 

 
7. Extrude away from the assembly using a distance of 20mm: 

 
8. New Sketch on the resulting face and add two lines as shown, with 20mm 

dimensions from the edges: 
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9. Finish the sketch and Extrude the shapes 160 mm: 

 
10. Add a Full Round Fillet to the ends of the shapes you just extruded. Here 

is where you get to practice making full round fillets, the key is where you 

select on the face you wish to be rounded: 

 
11. This is the intended result: 
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12. Create another Ø15 mm hole, on this face, and drag the center point to 

be co-located at the center of the full round fillet arc: 

 

 
 

13. Create a rigid As-Built Joint between the lower arm end bracket and the 

center actuator shaft: 
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14. Click OK, you’re done with this part! 

 

Commands used: 

• New component 

• Offset plane 

• New sketch 

• Sketch project geometry 

• Sketch center rectangle 

• Sketch line 

• Sketch dimension  

• Extrude 

• Hole 

• As-Built joint 
 
Insights:  

• Modeling in place is supported by offset planes and sketch projections. These 
help place sketches where you need them and make parametric relationships 
between the parts in your design. 
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Step 12 – Claw Pivot 
 

 

 

CLAW PIVOT  (SELECTED) 

 
1. Activate the top level browser node. 

2. Create > New Component, “claw pivot”, activate it. 

3. New Sketch on the inside face of the lower arm end bracket: 
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4. Extrude the two profiles created in the sketch, using Extent Type: To 

Object. Select the opposite inside face of the lower arm end bracket as 

the object: 

 
 

5. Create a New Sketch on top of the new body. Add a 2-point Rectangle 

and dimensions to create this shape: 
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6. Extrude the rectangle as a cut through the body: 

 

 
 

7. Add an As-Built revolute joint between the lower arm end bracket and 

claw pivot: 

 

 
 

8. Add a Ø15 mm Hole to the center of the outer face on the claw pivot. 

Remember the method to drag the hole center point to enable the center 

snap point on the face. When a small white dot appears in the center of 

the face, drag the hole center to it and observe the snapping action: 
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Commands used: 

• New component 

• New sketch 

• Sketch circle 

• Sketch line 

• Sketch dimension  

• Extrude 

• Hole 

• As-Built joint 
 
Insights:  

• For extruded parts, placing the sketch plane on another component surface and 
terminating the extrude using To Object will create a parametric relationship. In 
this case, if the lower arm end bracket changes size, the claw pivot will adjust to 
fit inside of it, by design. All you had to do is pick the start and end conditions for 
the extrude by simple modeling techniques. 
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Step 13 – Gripper Bracket 
 

 

 

GRIPPER BRACKET (ACTIVATED) 

 
1. Activate the top level browser node. 

2. Create > New Component, “gripper bracket”, activate it. 

3. New Sketch, select the top of the claw pivot as the sketch location: 
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4. Using 2-point Rectangle, lines, circles, and dimensions, create this figure 

in the sketch: 

 

 
 

5. Extrude the inner profile defined by this sketch.  Use “To Object” as the 

Extent Type, selecting the bottom face of the “claw pivot” component: 
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6. We will need to add a cut to this bracket, to allow room for the gripper 

claws.  Create a New Sketch on the end face of the extruded body, and 

draw a 2-Point Rectangle that is bigger than the body: 

 

 
 

 
 

7. Create a Cut Extrude feature, selecting all 3 profiles from the sketch.  Use 

To Object for the Extent, and use an Offset of -20 mm to guarantee 

material thickness on the back side of the bracket: 
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8. Add a Ø15 mm Hole to the back of the bracket, in the center of that face: 

 
 

9. Add an As-Built Joint, revolute, between the new “gripper bracket”, and the previous 

“claw pivot” component, selecting the Hole as the Snap: 
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Commands used: 

• New component 

• New sketch 

• Sketch circle 

• Sketch line 

• Sketch dimension  

• Extrude 

• Hole 

• As-Built joint 
 
Insights:  

• When using Extrude to cut out some geometry in a body, use To Object + an 
Offset value to maintain material on that side of the body. Extending your 
understanding of each command starts by exploring and practicing the options in 
each command dialog box. 
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Step 14 – Gripper Assembly 
 

 
GRIPPER ASSEMBLY (ACTIVATED) 

 
1. Create > New Component, “gripper assembly”, activated. 
2. Create > New Component, “rear gripper arm”, activated: 

 
3. Create > New Sketch on the lower inside face of the “gripper bracket”: 
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4. Draw this sketch – a dimensioned construction line from the existing hole in the bracket, 
horizontal, plus two circles, one at each end of this line, with tangent lines between the 
outer circles.   
 

a. Note: These lines can be created by mouse down on the circle, and dragging to 
the other circle, snapping to tangent points.  This is a great skill to learn.  Make 
sure to add a circle at the small end of the arm to form a hole: 

 
 

5. Extrude the profile, using To Object, and selecting the upper face of the “gripper 
bracket”: 
 

 
6. Just like we needed to hollow out the “gripper bracket” component, we need to do the 

same for this arm, to allow room for the actual gripper component.  But, we will do this 
one differently, using the sketch for the previous Extrude.  Make it visible, then start 
Extrude.  Select a subset of the profile from the sketch, as shown.  Use To Object again, 
selecting the top face of the extruded body.  But, we will use 2 offsets this time, to keep 
material on both sides of the body.  This is another useful trick to know: 
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7. Activate the “gripper assy” component, then Create > New Component, to create the 
“front gripper arm” component.  Construction of this arm is exactly the same process as 
the rear arm, just different sketch dimensions: 

 
8. Create > New Sketch, again on the lower surface of the “gripper bracket”.  Create this 

sketch: 

 
 



 
 

 

 

Page 69 

9. Extrude, as above: 

 
 

10. And, again, as above, Extrude Cut, using the sketch, To Object, and two offsets: 
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11. Activate “gripper assy” again, and Create > New Component, to create the “gripper” sub-
component: 

 
12. Create > New Sketch, choosing the inner face of “rear gripper arm”, and create a 

sketch like this: 

 
a. Here is where you can show some creativity:  Make your gripper look however 

you want, at whatever size (you’ll notice that there are no dimensions on our 
version…) 

 
 



 
 

 

 

Page 71 

13. Extrude, using To Object, selecting the upper face of either of the arms: 
 

 
 

14. Add a Full Round Fillet to the back of the gripper: 

 
 

15. And, add another Fillet feature (this time:  Edge Fillet) to fillet the remaining sharp edges.  
Use whatever radii you feel looks best.  Again, room for creativity here: 
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16. Add Joints.  Four Joints are needed.  All 4 are As-Built Joints, Revolute: 
 

 
Two of these Joints are internal to the “gripper assy” component, and two are owned by 
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the root component.  We will see the effect of this in the next step, since only two will be 
needed for the other instance of this assembly. 

 
Commands used: 

• New component 

• New sketch 

• Sketch circle 

• Sketch line 

• Sketch dimension  

• Extrude 

• Hole 

• As-Built Joint 
 
Insights:  

• We learned another way to add a cutout region to a body, along the extrusion 
direction of the first Extrude.  Re-use the profile sketch (but with an Offset from 
the profile plane), and use To Object + an Offset value to maintain material on 
both sides of the body. 
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Step 15 –  Second Instance of the Gripper Assembly 
 

 
 

SECOND INSTANCE OF GRIPPER ASSY 

 
1. Now, as with the other sub-assemblies used in this model, we need a second 

instance.  This one, also, needs to be rotate.  So, the first step is to Copy “gripper 
assy”, and use Paste.  When the move dialog appears, rotate the assembly by 180 
degrees, and translate it to the other side of the gripper bracket.  You do not have to 
get it exact, just close: 

 
 

2. Make the Joints.  The first will be a “regular” Joint (not As-Built), because the second 
instance is not in position.  You can choose either the front or rear arm.  We chose 
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the rear arm.  Choose the top of the hole on the arm, and the bottom of the hole in 
the bracket as the snap points: 
 

 
 
 

3. Because the rest of the assembly will move with that joint, the second revolute joint 
can be an As-Built Joint: 
 

 
 
Important:  The revolute joints between the arms and the gripper do not need to be 
created in this instance.  Because those joints are owned by the “gripper assy” 
component, they come along for the ride. 
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Commands used: 

• Copy/Paste of a Component 

• Joint 

• As-Built Joint 
 
Insights:  

• We learned that Joints that are internal to a sub-assembly will come across when 
a new instance of that sub-assembly is created, and that creating a “regular” 
Joint can also position a sub-assembly so that an As-Built Joint can be added. 

 
  



 
 

 

 

Page 77 

 

Appendix 1 - Command list 
Click on each item to see the reference documentation for that command. 
 

Create component  
Create Sketch  
Sketch Line  
Sketch Circle  
Sketch Dimension 

Sketch Rectangle 

Sketch Project 
Sketch Project->intersect 

Extrude   
Hole  
Fillet  
Offset plane 

Copy/Paste Component 

Joint  
As-Built Joint 
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